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Exercise 1: Make a map

n How can | print an exercise to PDF format?

Instructions
Use this guide and ArcGIS Pro to reproduce the results of the exercise on your own.

Note: The version of ArcGIS Pro that you are using for this course may produce slightly different results from the graphics that you see in the course
materials.

Software requirements
* ArcGIS Pro 3.5.X (latest version)

* ArcGIS Pro Standard license (or higher)

The MOOC provides a separate ArcGIS account (username and password) that you will need to use to license ArcGIS Pro and access other software
applications used throughout the MOOC exercises. This account (username ending with _cart) provides the appropriate ArcGIS Online role, ArcGIS Pro
license, ArcGIS Pro extensions, and credits.

We strongly recommend that you use the provided course ArcGIS account to ensure that you have the appropriate licensing to complete the
exercises. Exercises may require credits. Using the provided course ArcGIS account ensures that you do not consume your organization's credits. Esri
is not responsible for any credits consumed if you use a different account. Moreover, Esri will not provide technical support to students who use a
different account.

Introduction
A map is a graphic—either static or dynamic—that conveys a geographical story. In other words, a map is a visual thing that communicates spatial things.
All three aspects—uvisual, spatial, and communication—are vital to the success of your map.

Sometimes, the story is about intangible or invisible phenomena. Sometimes, it is about how something changed over time. And sometimes, it is just a
detailed accounting of the reality of a place.

The spatial component of your map is the data that you use to tell the story. Making sure that your data is relevant and authoritative is vital to ensuring that
your map is credible. Authoritative data generally refers to data that comes from an official and trusted source, which has been checked and tested for
accuracy, and that is intended for use and reuse by the public.

The visuals are the symbols, symbology methods, text, and layout elements that you choose to support your story. It is through these elements that you tell
your story.

And the communication is how you tell that story. This is the most nebulous part of the process, but it is what can make the difference between an ordinary
map and a compelling one. The design choices set the tone and clarity of your map and dictate how the map communicates.

What will you learn?
This course will teach you the balance between the art and science aspects of mapmaking. To begin, this exercise teaches you the mechanics of making a
map in ArcGIS Pro. You will get comfortable with ArcGIS Pro and learn how to create a project to store your work.

In this exercise, you will begin making a small-format reference map of the U.S. state of Massachusetts for the purpose of printing.

If this is your first time using ArcGIS Pro, you may find the ArcGIS Pro Terminology Guide
(https://links.esri.com/ArcGISProTerminology) helpful.

The exercises in this course include View Result links. Click these links to confirm that your
results match what is expected.

Estimated completion time in minutes: 60 minutes

Expand all steps w Collapse all steps

- Step 1: Download the exercise data files

In this step, you will download the exercise data files.
In a new web browser tab, go to https://links.esri.com/Sec1MakeAMap.

Download the exercise data ZIP file.

The complete URL for the exercise data ZIP file is https://www.arcgis.com/home/item.html?
id=f4b8eccbf7934c4fade38b80c5708817. The file is 16 MB.

Extract the files to a folder on your local computer, saving them to a location that you will remember.

Close the web browser tab with the item page.
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Collapse &

I - Step 2: Confirm system requirements

In this step, you will run a test to confirm that your computer can support ArcGIS Pro. Even if you have ArcGIS Pro installed, you should confirm that
it can support ArcGIS Pro 3.5.

a In a new web browser tab, go to Esri's system check site (https://links.esri.com/CanYouRunlt).
b Click the Run Tech Check button.
¢ Follow the steps to open and run the test.
The site generates a report that lists the minimum requirements and identifies whether your machine meets these requirements.

d If your computer does not meet these requirements, use the provided links to complete the recommended updates, and then run the test again.

Note: If your computer does not meet the requirements, you may need to use a different computer
or update your graphics card. For more information about graphic card requirements, go to
ArcGIS Pro Help: ArcGIS Pro 3.5 system requirements.

e If your computer meets the requirements, save the report.

Note: The MOOC team may ask you to share the report if you need help in later ArcGIS Pro
exercises.

f Close the web browser tab with Esri's system check site.

Collapse &

I - Step 3: Install ArcGIS Pro

This MOOC uses ArcGIS Pro 3.5.

Note: Complete this step if you do not have ArcGIS Pro 3.5 installed. If you already have ArcGIS
Pro 3.5 installed, proceed to the next step.

a Open a web browser tab in incognito mode and go to www.arcgis.com.

b Sign in using your provided course ArcGIS credentials (username ending with _cart).

Note: The course ArcGIS account username and password are listed on the main Cartography.
MOOC page under Lessons. The username for this account ends with _cart (for example,
jsmith_cart). You may want to write down the username and password for quick reference.

Cartography.

Feb 3, 2021 - Mar 17, 2021

Lessons Ferum

LeSSO NS  The courseis organized into sections that contain lessons. Complete each section to earn a certificate.

Step 3b***: Install ArcGIS Pro.

The MOOC provides a separate ArcGIS account (username and password) that you will need to use to license ArcGIS Pro. This is not the same
account that you used to access the MOOC.

Note: If you registered within the past few hours, your account may not be ready. Refresh the page
in an hour or so to determine if your account is available.

¢ In the upper-right corner, click your account, and then click My Settings, as shown in the following graphic.
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P MOOC Student Name

zz_cant

MOOC Student Name

Under My Settings, on the left, click the Licenses tab.

Under Licensed Products, find ArcGIS Pro, and then click Download ArcGIS Pro.

Licensed products ® Add-on license
Q Search licensed products
License

> -' Essential Apps
> 9." Field Apps

> @.’ Office Apps

@‘ ArcGIS Pro + Download ArcGIS Pro

@ ArcGIS Runtime Standard

The Download window opens.

You can run ArcGIS Pro in a different language by clicking the down arrow next to English
(Version 3.5) and choosing a different supported language. Keep in mind that this course is
taught in English, which means that all graphics and exercises will use the English version of
ArcGIS Pro.

Click Download.

If the default download location does not have enough space, you can change the location by following the steps outlined at this link:
https://links.esri.com/ChangeDownloadLocation.

After the download completes, double-click the .exe file.
Follow the installation instructions, accepting all defaults.

After you are finished installing ArcGIS Pro, close the incognito web browser tab.

Collapse &

I - Step 4: Sign in and update ArcGIS Pro

Before you begin, you will install an update to ArcGIS Pro.

Complete this step if you do not have the last ArcGIS Pro update installed. If you already
have the ArcGIS Pro 3.5.X (latest version) update installed, proceed to the next step.

Start ArcGIS Pro, if necessary.

In the upper right, click Not Signed In, and then click Sign In.

If you are already signed in to ArcGIS Pro with a different account, click Sign Out, and then
click Sign In.
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ArcGIS Pro wants to access your ArcGIS Online account infarmation (7))

Sign in with &9esri

| ArcGIS login

& Username

B Password

Forgot username? or Forg
Your ArcGIS organization's URL

9) 0 G o

Step 4b***: Sign in and update ArcGIS Pro.

Sign in to ArcGIS Pro using your provided course ArcGIS credentials (username ending with _cart).
On the left side, click Settings.

Click the About tab, if necessary.

Mew

Open

Portals

Licensing
Options

Package Manager

Add-In Manager

Help
About

Learning Resources
Exit

Step 4e***: Sign in and update
ArcGIS Pro.

Under Software Update, click Download Now.

ArcGIS Pro will automatically begin downloading and installing the update.

After the update is installed, the Download Manager dialog box will open, notifying you that the update succeeded.
In the Download Manager dialog box, click No.

You have updated ArcGIS Pro to the latest version.

Exit ArcGIS Pro.

Collapse &
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- Step 5: Add data to a new map

You will start by opening a project package from the data that you downloaded.

In File Explorer, browse to the location where you saved your data.

Double-click the MakeAMap_InitialState packaged project file to open the exercise project in ArcGIS Pro.
You will use the contents of the exercise project to make your map.

You will use the Catalog pane to access a database containing the data for the Make A Map project. The Catalog pane provides an inventory of
items in your project and the commands to manage them.

Open the Catalog pane, if necessary.
- Hint
1. On the ribbon, click the View tab.

2. In the Windows group, click Catalog Pane.

In the Catalog pane, expand Databases, and then expand the makeamap_initialstate project geodatabase.

Project Portal Computer Favorites =

|?| Search Project L v

Toolboxes
4 |5l Databases
el [-:’EL‘ makeamap_initialstate.gdb
@ Counties_northeast
= Highways_MA
C] Institutions_MA
[E Parks_MA
C] Places MA
@ Urban&reas_MA
b g Styles
™ Folders

b B Locators

Step 5d***: Add data to a new map.

On your keyboard, press the Ctrl key, and then click each feature class in the project geodatabase except the Institutions_MA feature class to select

them.
If you wish to complete any stretch goals at the end of this section, you may also want to
select and add the Institutions_MA feature class.
Project Portal Computer Favorites =
7 | Search Project P v
@& Toolboxes
4 5 Databases

4 [_:;_;} makeamap_initialstate.gdb
Counties_northeast
Highways_MA

() Institutions_MA
Parks_MA

a Places_MA
Urban&reas MA

b g Styles

w Folders

b Locators

Step 5e***: Add data to a new map.

Right-click the selection, point to Add To New, and choose Map, as shown in the following graphic.
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Catalog v B X

Project Portal Computer Favorites

|?| Search Project P v

I [ Toolboxes
4 5l Databases

4 [-:”:L‘ makeamap_initialstate.gdb
Counties_northeast
Highways_MA
[z Institutions_MA
Parks_MA
a Places_MA
Urbanfreas MA

|ﬁ Map | +  Add To New >
@ Global s i
ol Llobal scene E:q Open Table Ctrl+Shift+T
4
& Local Scene Load Data
Export b
[%‘ Manage Replicas
s cut Ctrl+X
@ Copy Ctrl+C
Copy Path Ctrl+Alt+P
[ Delete Crl+D

A new map is created with a basemap that provides a background of geographical context. The map is zoomed to the extent of the data layers in the
northeastern part of the United States.

Close the Catalog pane.
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Step 5g***: Add data to a new map.

ArcGIS Pro randomly assigns colors, so the colors in your map may differ from the interface
as shown in graphics throughout this course.

The left side of the ArcGIS Pro window displays the Contents pane, which lists the layers contained in the current map. In the Contents pane, you
can manage the display of layers, symbology, and other layer properties.

Using the check boxes next to the layer names in the Contents pane, you control which layers are drawn in the map or scene at any given time. You
can remove the Topographic basemap because it is not needed in the general reference map that you will make.

- Hint
To open the Contents pane from the ribbon, click the View tab, and then in the Windows group, click Contents.
In the Contents pane, right-click the Topographic basemap layer and choose Remove.
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Step 5h***: Add data to a new map.

If you are not using the Cartography. organization, you may see other basemap layers.
Remove all basemap layers from the map.

The basemap layer has been removed from the map.

Collapse &

l - Step 6: Set the map properties

Next, you will set properties to improve the display and organization of your map.

In the Contents pane, right-click Map and choose Properties to open the Map Properties dialog box.
You can also double-click the map name to open its properties.

On the General tab, in the Name field, you can see that the map is currently named Map.

In the Name field, type Massachusetts as the new name for the map.

On the left side of the Map Properties dialog box, click the Metadata tab.

It is good practice to include metadata for your map. When someone else wants to use your map in the future, the metadata provides context and
understanding of what the map is for and where the data came from. For more information, go to ArcGIS Pro Help: View metadata
(https://links.esri.com/ViewAndEditMetadata).

On the Metadata tab, type a title for your map, such as Reference Map of Massachusetts.
Add some descriptive tags, such as Massachusetts, Places, Highways, and any others that you would like.
Type a summary for the map, such as General reference map of the state of Massachusetts.

Finally, type a description for your map, such as This reference map shows the northeast region of the United States and focuses on the state
of Massachusetts.

You can use the Summary and Description shown in the following graphic, or you can write
your own.
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Map Properties: Map m| X
General Title -
Extent | Reference Map of Massachusetts
Clip Layers Tags
Metadata Massachusetts
Coordinate Systems Eiliagc;\,s\rays
Transformation

Summary
Illuminati
uminatien General reference map of the state of Massachusetts.
Labels
Color Management Description

This reference map shows the nertheast region of the United States and
focuses on the state of Massachusetts.

Credits

Use limitations

oK || Cancel || Apply

Step 6g***: Set the map properties.

After providing the metadata, click the Coordinate Systems tab.

Maps and scenes use coordinate systems to locate and display data correctly on the earth's surface and relative to one another. A coordinate
system is a reference framework that defines the position of features in either two- or three-dimensional space. For more information about
coordinate systems, go to ArcGIS Pro Help: Coordinate systems, map projections, and transformations (https://links.esri.com/CoordSysProjections).

In a GIS map, you work with geographic data through layers. Layers are collections of geographic data, such as features or imagery.

Currently, all layers in your map are unprojected in the WGS 1984 geographic coordinate system. Unprojected coordinate systems apply the
geographic coordinates of the (nearly) spherical globe to the page or screen on a rectangle. This is why the states look a bit stretched. A projected
coordinate system applies a mathematical adjustment to the coordinates to project their image onto the page or screen.

Projected coordinate systems all have limitations, but you can choose and manage the specific limitations to meet the needs of your map.

You will change the coordinate system for your map to an Albers projection. Albers is an equal-area projection, which keeps the size of areas on the
map true to their size relative to the globe. This comes at the price of minor scale and shape distortions. The Great Lakes Basin Albers projection is
designed to minimize distortions specifically in the Great Lakes Basin area of North America. You will learn more about coordinate systems later in
the course. For more information about the Albers projection, go to ArcGIS Pro Help: Albers (https:/links.esri.com/Albers).

On the Coordinate Systems tab, scroll down the list of coordinate systems to find and expand the Projected Coordinate System section.
Expand the Continental section, and then expand the North America section.
Click the NAD 1983 Great Lakes Basin Albers projection to select it.

Click OK to apply the coordinate system and close the Map Properties dialog box.
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Step 6/***: Set the map properties.
Because the Albers equal-area projection minimizes distortion, it is well-suited for areas of interest that trend east-west, like Massachusetts. You will
notice that Massachusetts no longer looks stretched.
As you work, it is a good idea to periodically save your map.
On the ribbon, click the Project tab, and then click Save Project As.

Browse to the MakeAMap folder on your computer and save your map as MyMassachusettsMap_<your first and last name>.aprx.

Throughout the course exercises, you will be prompted to save your work with a unique
identifier, such as your first and last name, at the end of the filename, so you do not
overwrite the original project.

If you are continuing to the next exercise, leave ArcGIS Pro open; otherwise, exit ArcGIS Pro.

Collapse &
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